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1 Choix du matériel 
 

1.1 Détecteur d’ultrasons 
 
Dans ce manuel, nous partons du principe que le lecteur utilise un détecteur à expansion de temps. 
Etant donné que nous utilisons nous-mêmes un modèle Pettersson D240x, ce manuel est basé sur 
l’utilisation de ce matériel, mais loin de nous l’idée de promouvoir ce modèle (d’autres appareils 
équivalents sont très bons également). Quiconque travaille avec un autre détecteur pourra facilement 
utiliser ce manuel malgré quelques petites différences.  Une liste des principaux fabricants de 
détecteurs à expansion de temps se trouve en annexe 1.  
 
L’objectif de ce manuel n’est pas de discuter des différences entres marques ou modèles ; 
néanmoins, ces différences seront de temps en temps mises en évidence.  Les observateurs qui 
utilisent par exemple un appareil de la série D1000x de Pettersson constateront une amélioration de 
la qualité des enregistrements, en particulier pour les hautes fréquences. Les détecteurs à 
enregistrement automatique (Pettersson D500x ou Wildlife acoustics SM2bat par exemple) permettent 
également une lecture en Batsound qui s’approche très fort de ce qui est décrit dans la partie 3 de ce 
manuel. 
 

1.2 Enregistreur  
 
Pour les enregistrements avec un Pettersson D240x, la plupart des utilisateurs possèdent 
actuellement un enregistreur numérique qui enregistre directement en format .wav.  Il est important 
d’éviter d’enregistrer en d’autres formats (.mp3, .mp4, …) car dans certains cas, ce type de 
compression dégrade trop le signal pour permettre une analyse appropriée à postériori.  Certains 
détecteurs portables (Pettersson D1000x, Batbox Griffin ou Wildlife acoustics EM3 par exemple) et 
tous les détecteurs automatiques ont aujourd’hui une carte mémoire interne permettant d’éviter 
l’utilisation d’un enregistreur extérieur.  Par ailleurs, il existe également certains micros directement 
branchés sur un ordinateur (tablette ou portable).  Pour plus d’infos sur les différents supports 
possibles, reportez-vous à l’annexe 2. 
 

1.3 Logiciel d’analyse 
 
Pour l’analyse de sons, il existe plusieurs logiciels dont plusieurs programmes gratuits.  Ce manuel est 
basé sur l’utilisation du logiciel Batsound, puisque c’est avec lui que nous travaillons nous-mêmes.  
Pour l’utilisation de ce programme, il faut une licence officielle.  Son achat est sous la responsabilité 
de l’utilisateur.  Batscan, SonoBat, Avisoft-SASLab Pro sont d’autres exemples de logiciels 
spécifiques pour l’analyse des sons de chauves-souris.  Une liste des fabricants de ce type de 
logiciels est incluse en annexe 1.  D’autres logiciels, comme les logiciels libres et/ou gratuits comme 
Praat, WaveSurfer, Syrinx, Audacity peuvent également être utilisés pour l’analyse des sons de 
chauves-souris, mais sont moins faciles à l’usage parce qu’ils ne sont pas spécifiquement construits 
pour l’analyse de signaux de chauves-souris. Leur avantage est qu’ils sont gratuits et qu’on peut donc 
faire des essais avant d’acheter un des logiciels plus spécifiques.  
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2 Enregistrement 
Connectez la sortie TAPE du détecteur 
avec l’entrée LINE-IN de l’enregistreur 
numérique.  Pour cela, vous avez 
besoin d’un câble audio stéréo avec 
deux fiches jack mâles de 3,5 mm 
disponible dans la plupart des 
magasins d’électronique (demandez 
un câble jack-jack stéréo 3.5).  
Attention : s’il y a deux entrées 
distinctes, ne pas connecter le câble 
sur l’entrée MICRO de l’enregistreur, et 
encore moins sur le LINE-OUT ou la 
sortie casque ! (NB : certains 
enregistreurs comme les modèles 
ZOOM H2N n’ont plus qu’une seule 
entrée ligne, couplant MICRO et LINE-
IN, c’est donc celle-là qu’il faut choisir). 
 
 

Les enregistrements sur le détecteur sont 
réalisés en stéréo : l’hétérodyne est 
enregistré sur le canal gauche (piste 
gauche ou oreille gauche), l’expansion de 
temps sur le canal droit (piste droite ou 
oreille droite).  Ces signaux en expansion 
de temps ne sont pas produits en 
continu : seules quelques secondes du 
signal entrant sont enregistrées dans la 
mémoire interne du détecteur.  Chez le 
D240x, l’utilisateur peut configurer cette 
durée d’enregistrement à 0.1 seconde, 
1.7 s ou 3.4 s à l’aide d’un petit bouton 
situé sur la face arrière du détecteur.  
Considérons dans l’exemple suivant que 
l’utilisateur a réglé son détecteur sur 1.7 s.  
Tant que la lampe rouge sur la face du 
détecteur est allumée, le détecteur 
enregistre en continu, en ne gardant que 
les 1.7 dernières secondes en mémoire.  
Pour arrêter cet enregistrement, il suffit de 
pousser sur le bouton* à l’arrière du 
détecteur (voir image ci-dessous).  La 
lampe rouge s’éteint alors et le détecteur 
garde en mémoire les 1.7 secondes 
précédant la pression du bouton* et ce, 
jusqu’à ce que l’utilisateur repousse sur 
ce même bouton*.  Tant que l’utilisateur 
n’arrête pas l’enregistrement, le détecteur 
ne gardera en mémoire que les dernières 0.1 s, 1.7 s ou 3.4 s selon le choix de l’utilisateur.  Une fois 
que l’utilisateur pousse sur le bouton pour arrêter l’enregistrement, les signaux dans la mémoire sont 
ralentis 10 fois (le temps est expansé d’un facteur 10), ce qui donne un signal en expansion de temps.  
Cette transformation ne se passe pas en continu, mais uniquement après avoir arrêté l’enregistrement 
soit manuellement (comme expliqué ci-dessus et voir point 2.1) soit par le déclenchement 
automatique TRIGGER (uniquement chez le D240x, voir point 2.2 pour plus d’info sur cette fonction). 
 
Le signal en expansion de temps passe sur le canal droit.  Si vous utilisez des écouteurs, vous 
entendrez le signal en expansion de temps dans l’oreille droite et le signal hétérodyne dans l’oreille 
gauche (repérerez les lettres L (gauche - bleu) et R (droite - rouge) sur les écouteurs). 

17 sec 
Signal en 

expansion de 
temps

Signal  
entrant 

1.7 sec en 
mémoire

Arrêt manuel 

Déclenchement 
automatique 
TRIGGER 

(uniquement 
chez le D240X)

 Lampe rouge   
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2.1 Enregistrement manuel 
 
Etape 1 : créer un signal en expansion de temps 
 
L’enregistrement manuel s’effectue avec le bouton* noir (manual 
start/stop) sur l’arrière du D240x, comme expliqué ci-dessus.  Quand on 
presse le bouton, la mémoire n’est plus remplacée par de nouveaux 
signaux et le son gardé en mémoire est expansé.  L’avantage est donc 
que vous pressez le bouton d’enregistrement après le passage de la 
chauve-souris.  
 
Etape 2 : enregistrer sur l’enregistreur numérique 
  
En poussant sur le bouton REC ou RECORD de l’enregistreur, les signaux 
du détecteur sont enregistrés.  Faites bien attention que l’enregistreur soit 
configuré en mode stéréo, car les signaux hétérodynes sont transmis par 
le canal gauche et les signaux en expansion de temps passent par le 
canal droit.  Il est également bon à savoir que le D240x travaille en 
44.1 kHz de fréquence d’échantillonnage et en 16 bits, les réglages de 
l’enregistreur doivent donc suivre ces mêmes paramètres, sinon vos 
enregistrements ne seront pas exploitables.  
 
Au bout du temps nécessaire pour que l’entièreté de l’enregistrement soit 
passé (soit 17 sec dans notre exemple), poussez sur le bouton STOP de 
l’enregistreur pour arrêter l’enregistrement.   
Il est important de noter que le même signal en expansion de temps de 
17 s est joué en boucle en continu tant que vous n’avez pas recommencé 
une nouvelle session d’enregistrement (en poussant sur le bouton*).  Vous 
avez donc tout le temps de faire les manipulations nécessaires pour l’enregistrement.  Conseil : veillez 
à repérer à l’écoute le début de la séquence expansée (on entend en général un clac caractéristique) 
afin d’une part d’enregistrer la séquence entière en commençant bien au début (et non en plein milieu) 
et en finissant à la fin, et d’autre part sans tronquer une partie ni enregistrer 3 fois la même séquence.  
 
Il est également possible d’enregistrer en continu, mais vous obtenez alors un très long fichier rempli 
de signaux hétérodynes avec de temps en temps un morceau en expansion de temps.  Vu que seules 
les séquences en expansion de temps seront utilisées par la suite, il est intéressant de n’enregistrer 
que lorsque vous avez des signaux de ce type.  
 
 
 Conseil 1 : utilisez le bouton COM (commentaire) du détecteur  
Afin de se rappeler plus tard où, quand et dans quelles conditions ont été réalisés les 
enregistrements, utilisez le bouton COM.  Ce bouton noir, situé sur la face du détecteur juste en-
dessous de la lampe rouge, permet d’enregistrer des commentaires en parlant dans le micro du 
détecteur.  Il est conseillé (voire essentiel) de faire des commentaires après chaque enregistrement en 
expansion de temps.  Dans ce cas, une fois la séquence à enregistrer terminée, avant de pousser sur 
STOP, poussez sur le bouton COM du détecteur et faites vos remarques (par exemple, la date et le 
lieu, l’impression en hétérodyne, les conditions d’enregistrement, le type d’habitat, etc). 
 
 Conseil 2 : notez les conditions d’enregistrement 
Notez ou enregistrez (via le bouton COM, cf. conseil 1) les conditions d’enregistrement pour chaque 
séquence.  Par la suite, et en particulier si il y a un certain délai entre l’enregistrement et l’analyse, ces 
remarques permettent de resituer l’enregistrement.  En effet, les conditions ont une très forte influence 
sur les signaux utilisés par les chauves-souris et leur connaissance est une condition essentielle pour 
pouvoir déterminer l’espèce. 
 

bouton * 
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 Conseil 3 : vérifiez systématiquement les réglages du détecteur avant chaque 
enregistrement 

Le détecteur D240x possède toute une série de boutons.  Il n’est pas rare, pendant le transport ou 
lorsqu’on emballe ou déballe le détecteur dans sa housse, que la position des différents boutons 
change.  Il est dès lors utile de vérifier systématiquement tous les boutons en début de soirée et avant 
de commencer l’enregistrement. 
 
 Conseil 4 : prévoyez un câble et une pile de réserve  
Le câble qui relie de détecteur à l’enregistreur est le point faible du système.  En le pliant ou en 
restant par mégarde accroché à une branche, le câble peut facilement être endommagé.  Pour éviter 
la frustration de se retrouver en forêt au milieu de la nuit avec un câble endommagé, prévoyez 
toujours un exemplaire de réserve.  Encore mieux, mais plus cher, achetez un câble en silicone avec 
des fiches jack en or.  Dans le même ordre d’idée, prévoyez toujours des piles de rechange (pour le 
détecteur ET pour l’enregistreur) et ayez-les sur vous pendant l’inventaire. 
 
 Conseil 5 : prenez l’habitude d’écouter le son en expansion de temps 
Prenez l’habitude d’écouter le son en expansion de temps pendant que vous l’enregistrez.  Ceci vous 
permettra de vérifier que l’enregistrement se passe bien et de vous faire l’oreille à l’écoute des 
signaux en l’expansion de temps.  Ceci sera important plus tard à l’apprentissage de la méthode 
Barataud. 

 

2.2 Déclenchement automatique TRIGGER 
 
Chez le D240x, il y est possible que le détecteur évalue lui-même quand un signal à expansion de 
temps doit être créé.  Il faut pour cela sélectionner une valeur seuil de son. Lorsque ce seuil est 
dépassé, la mémoire est automatiquement transformée en expansion de temps.  La valeur seuil peut 
être réglée à l’aide d’une petite vis à l’arrière du détecteur (LEVEL ADJ). 
  
Cette méthode de déclenchement est surtout intéressante quand le détecteur et l’enregistreur sont 
abandonnés quelque part pour évaluer l’activité des chauves-souris à cet endroit.  La durée totale 
d’enregistrement est limitée par la capacité de la carte de l’enregistreur et/ou par la durée de vie des 
batteries.  Les autres limitations de cette technique sont le danger de vol et le fait que le détecteur 
enregistre tout son au-dessus du seuil, y compris des bruits non désirés (voitures qui passent, 
sauterelles, vent, …).  Enfin, par la suite, il faut écouter toute la bande et l’analyser, ce qui peut être 
contraignant.  Notons tout de même qu’il existe actuellement des systèmes d’enregistrement 
automatique bien plus performants et adaptés que le D240x pour ce genre d’utilisation.   
 
Le mode TRIGGER est également utilisé dans certaines méthodes de transects en voiture ou à vélo 
par exemple.  Le seuil est alors placé très bas afin que le détecteur enregistre automatiquement 
toutes les chauves-souris qui passent. 
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3 Lecture des enregistrements sur l’ordinateur 

3.1 Transfert des enregistrements vers l’ordinateur  
Il existe plusieurs moyens simples de transférer des données de l’enregistreur (ou de la carte interne 
au détecteur) vers l’ordinateur : 

- Connecter l’enregistreur à l’ordinateur : utilisez le câble de transfert fourni avec l’enregistreur 
pour le connecter à l’ordinateur via le port UBS. 

- Insérer la carte mémoire de l’enregistreur/détecteur dans un lecteur de cartes adapté branché 
sur le port UBS de votre ordinateur.   

- Insérer la carte mémoire dans le lecteur de cartes de votre ordinateur, s’il en possède un 
adapté. 

Dans les 3 cas, ouvrez le dossier de votre carte mémoire, et importez les fichiers depuis la carte 
mémoire de l’enregistreur vers un dossier sur votre ordinateur.   

 

3.2 Paramétrages initiaux de Batsound 
 
Quand vous démarrez le logiciel Batsound pour la première fois, il est nécessaire de configurer une 
série de paramètres de base.  Au démarrage de Batsound, vous arrivez sur l’écran de démarrage et 

vous devez d’abord ouvrir un fichier vierge grâce au bouton  ou via le menu File > New. 
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3.2.1 Configuration de l’enregistrement 
 
Allez vers Sound > Sound Format 
 

 
 
Vous obtenez la fenêtre suivante : 
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 Bits per sample : Ce paramètre doit être réglé en fonction des caractéristiques de votre 
détecteur.  Sélectionnez 16 bits pour une qualité de son optimale. 

 Channels : Sélectionnez Stéréo si vous souhaitez que les pistes gauche et droite soient 
séparées.  Puisque les signaux hétérodynes et expansion de temps sont enregistrés sur deux 
canaux différents, il est nécessaire de séparer les deux canaux. 

 Samples per second : Le nombre de Samples per second sélectionné par la plupart des 
utilisateurs de D240x est 44.100, cela correspond à la fréquence d’échantillonnage réglée sur 
votre enregistreur.  Les utilisateurs d’un autre type de détecteur (par exemple les détecteurs 
automatiques) doivent adapter cette fréquence d’échantillonnage aux paramètres de leur 
matériel. 

 Time expansion : Le Time expansion factor doit être sélectionné en fonction du détecteur.  
Pour le D240x, ce facteur est toujours 10 (c’est le facteur de ralentissement de 
l’enregistrement).  Sur d’autres détecteurs, soit on peut choisir ce facteur sur le détecteur 
(10x, 20x) soit il s’agit de 1x quand on fait de l’enregistrement direct. La plupart des 
utilisateurs sont habitués à écouter les sons ralentis d’un facteur 10. 

 Dans le cadre Comments, vous pouvez rajouter vous-même de l’information sur votre 
enregistrement : la date d’enregistrement, l’auteur de l’enregistrement, des remarques (par 
exemple une identification).  Ces commentaires ne seront conservés que si vous enregistrez 
votre ficher sous un format wav Batsound (voir point 3.3). 

 

Une fois les paramètres adaptés, cliquez sur  

3.2.2 Paramètres du spectrogramme 
 
Bien que ce ne soit pas nécessaire de les paramétrer d’avance, vous allez vite constater à l’usage que 
vous préférerez travailler avec certains paramétrages.  Vous pouvez alors les régler par défaut, ce qui 
fait que tous les nouveaux enregistrements que vous ouvrirez seront paramétrés de cette manière-là.  
Il est cependant toujours possible de changer ces paramètres après l’importation du son.   

Allez vers Analysis > Spectrogram Settings – Default ou cliquez sur  
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 Vous obtenez la fenêtre suivante : 
 

 
 

 Milliseconds per plot : ce paramètre détermine la longueur de l’intervalle de temps affiché sur 
l’écran.  Il est recommandé de travailler avec un intervalle de temps d’une part suffisamment 
grand et d’autre part toujours le même, ce qui permet de voir d’un coup d’œil plusieurs signaux à 
la fois et d’évaluer directement (avec un peu d’habitude) le nombre de signaux par intervalle de 
temps. 500 millisecondes est un bon intervalle pour commencer et 200 millisecondes pour 
zoomer. Il est important de toujours utiliser les mêmes fenêtres afin de construire son propre 
référentiel visuel.  

 FFT size, FFT window et FFT Overlap sont des paramètres relatifs à la Transformation de Fast 
Fourrier (FFT) auquel le signal est soumis.  Une option facile est de maintenir les réglages par 
défaut.  Néanmoins, il est utile de savoir que plus le nombre FFT Size est élevé, plus la 
représentation de la fréquence sera précise (au détriment du temps), et à l’inverse plus le nombre 
est faible, plus le temps sera précis (au détriment de la fréquence).  Si vous devez faire des 
mesures précises de fréquence, utilisez donc une FFT Size de 1024 et si vous devez faire des 
mesures de temps (durées), utilisez une FFT Size de 512.   

 Threshold : en augmentant ou en diminuant le Threshold, on filtre plus ou moins le son.  Pour 
des signaux faibles, il convient de sélectionner un Threshold bas ; pour des signaux forts avec 
beaucoup de bruits parasites, il est recommandé de sélectionner un Threshold plus élevé (cf 
figure ci-dessous).   

 Amplitude color mapping permet de régler les couleurs utilisées dans le spectrogramme. Il est 
conseillé d’utiliser le schéma « Red, Green & Blue » car il permet de mieux visualiser l’enveloppe 
du signal et améliore la précision de certaines mesures.  Cette palette de couleurs est également 
intéressante car elle oblige un réglage approprié du Threshold. 

 If stereo, view : choisissez le canal de droite Right Channel, puisque c’est sur celui-là que 
passent les signaux en expansion de temps.  

 Grid Lines : vous pouvez choisir d’afficher des lignes pointillées discrètes en repère des 
fréquences et/ou du temps. 
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Cette figure montre le même enregistrement, mais avec le Threshold sur 11 à gauche et sur 5 à 
droite. 

 

3.3 Ouvrir des enregistrements existants en Batsound 
 
Quand vous (ou quelqu’un d’autre) avez sauvegardé des fichiers en Batsound ou importé des fichiers 
.wav sur l’ordinateur depuis un enregistreur, il est très facile de les ouvrir par la suite. Ceci peut être 

fait via File > Open ou avec le bouton  . 
 
Batsound ne peut lire que des fichiers sons en format .wav.  Il est cependant intéressant de noter que, 
pour Batsound, il y existe deux types de format wave : le wave Standard (Wave files) et le wave 
Batsound (BatSound Wave Files).  Le format wave Batsound ne peut pas être lu par d’autres 
programmes que Batsound lui-même, ce qui est un inconvénient important si vous ne travaillez pas 
uniquement avec ce logiciel ou que vous voulez partager votre enregistrement avec d’autres 
utilisateurs qui travaillent avec un autre logiciel.  Les formats wave Standard et wave Batsound 
peuvent tous deux être lus par Batsound, mais le wave Batsound conserve, lorsque vous quittez le 
programme, l’ensemble des paramètres que vous avez défini (spectrogram settings et autres 
configurations), au contraire du wave Standard.  Ceci signifie qu’à chaque ouverture d’un même fichier 
enregistré en wave Standard, vous devrez re-paramétrer l’affichage et la configuration, alors que le 
wave Batsound aura directement l’affichage que vous lui avez défini lors de l’utilisation précédente.  
Lorsque vous sauvez votre fichier son en Batsound (File > Save as), vous pouvez sélectionner le 
format voulu dans le menu déroulant Type du bas de la fenêtre. 
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3.4 Convertir d’autres formats son afin de les lire en Batsound 
 
Batsound ne peut lire que des fichiers sons en format .wav.  Si vous voulez visualiser un 
enregistrement en expansion de temps qui se trouve sur CD ou qui a été sauvegardé dans un autre 
format que .wav, vous devez le transformer avec un logiciel de transformation de son.  Aujourd’hui, de 
nombreux petits logiciels (Kaleidoscope ou Audacity par exemple) permettent de convertir des 
fichiers sons de différents formats vers du .wav.  Les utilisateurs qui travaillent avec du matériel 
Wildlife acoustics (SM2bat, EM3 etc) peuvent utiliser le logiciel Wac2Wav pour transformer les fichiers 
compressés wac en wav. Le seul risque à souligner est que l’on ne connaît pas toujours exactement 
la transformation effectuée par le logiciel (quel qu’il soit) sur le son.  Or ces transformations peuvent 
entraîner des modifications sensibles de la qualité ou des paramètres que l’on utilisera par la suite 
pour identifier l’espèce. Il convient donc d’être très prudents lorsqu’on transforme des sons d’un format 
vers un autre. 
 

3.5 Lire des sons en Batsound 

Une fois l’enregistrement ouvert en Batsound, vous pouvez le lire à l’aide du bouton  ou via le 
menu Sound > Play sound.  Hélas, l’écran ne défile pas automatiquement avec l’avancement de la 
lecture du fichier son, mais une barre verticale de progression permet de visualiser celle-ci.  Pendant 
la lecture, vous entendez également les commentaires enregistrés précédemment (avec le bouton 

COM).  Pour arrêter la lecture, poussez sur le bouton  ou allez dans le menu Sound > Stop Play 
sound. 
 
Si vous avez travaillé avec un détecteur automatique (D500x ou SM2bat par exemple), aucun facteur 
d’expansion n’a été appliqué aux enregistrements.  Pour l’écouter en expansion de temps, vous devez 
donc préalablement sélectionner une lecture ralentie de 10x via le menu Sound > Play speed > 1/10. 
 

Conseil 1 : Utilisez les raccourcis clavier  
 
Afin de parcourir les enregistrements, pour zoomer et dézoomer facilement, utilisez les raccourcis 
clavier.  Ils sont décrits in extenso dans le manuel de Batsound, mais nous vous rappelons ici les plus 
importants : 
 Ctrl + ► ou ◄ (les flèches gauche et droite) pour parcourir l’enregistrement 

 Ctrl + ▲ pour zoomer (le bouton  a le même effet) 

 Ctrl + ▼ pour dézoomer (le bouton  a le même effet) 

 Crtl + Shift + ▼ pour dézoomer sur la totalité de l’enregistrement (voir tout d’un coup) 
 

Conseil 2 : Utilisez des écouteurs 
 
Pour la détermination des espèces, la qualité du son que vous écoutez joue un rôle important. Il est 
donc fortement conseillé de travailler sur votre ordinateur avec des écouteurs ou un casque de bonne 
qualité et non avec les baffles intégrés à l’ordinateur.  Cela vous apportera un confort précieux et 
facilitera votre apprentissage. 
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4 Identification à l’aide d’analyses du son  
 
L’expansion de temps et l’analyse du son qui s’en suit ne sont certainement pas la panacée miracle.  
Ceux qui débutent feront probablement au départ l’erreur d’avoir trop confiance en cette technique.   
Il est également très important de se rendre compte que cette façon de travailler comporte une série 
d’inconvénients :  

 faire des enregistrements et les analyser prend beaucoup de temps 
 au moment de l’analyse, il est difficile de se rappeler des conditions d’enregistrement et 

d’évaluer les facteurs de l’environnement 
 l’enregistrement du son, son transfert sur l’enregistreur et ensuite sur l’ordinateur sont autant 

d’étapes qui peuvent modifier sensiblement le signal d’origine, rendant l’interprétation plus 
difficile, voire impossible dans certains cas. 

 
Il est dès lors préférable de prévoir un mélange intelligent de détermination directe en hétérodyne 
(voire en expansion de temps pour les plus aguerris) sur le terrain et d’enregistrements en expansion 
de temps analysés par la suite.  Il est également important de se rendre compte que toutes espèces 
de chauves-souris ne sont pas identifiables en expansion de temps.  Tout comme avec la méthode 
hétérodyne, il faudra régulièrement se résoudre à écrire simplement « Chauves-souris sp. » ou 
« Myotis sp. », preuve d’honnêteté intellectuelle et scientifique. 
 

4.1 Concepts de base  
 
Les chauves-souris utilisent des ultrasons pour s’orienter et 
pour localiser leurs proies.  Ceci est appelé écholocation.  Les 
Rhinolophes produisent les ultrasons par le nez et peuvent 
grâce à cela émettre de longs signaux sans interruption.  
Toutes les autres chauves-souris font des cris à intervalles 
réguliers (y compris les oreillards qui émettent par le nez 
également). Un cri est appelé signal, l’intervalle entre deux 
signaux est appelé intervalle inter-pulse (IPI).   
 
 

 
Au moment où la chauve-souris détecte 
une proie, la durée des signaux diminue 
mais leur récurrence (càd le nombre de 
signaux / seconde) augmente.  La durée 
du signal et de l’intervalle inter-pulse 
diminue.  C’est ce qu’on appelle la 
phase d’approche. Au moment où la 
chauve-souris est tout près de sa proie, 
les signaux se suivent très rapidement et 
on parle d’une phase de capture ou buzz 
de capture.  Il n’est pas certain que cela 
mène à une capture effective d’un 
insecte car souvent, la proie échappe au 
tout dernier moment. 
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Si toutes les chauves-souris chassaient de la même manière, il y aurait une forte concurrence pour la 
nourriture.  Au cours de l’évolution, chaque espèce a donc développé sa propre technique de chasse 
et de ce fait son propre type de sonar.  Dans les grandes lignes, nous pouvons différentier 4 types de 
sonar : 
 

I. Un premier type est le sonar en Fréquence Modulée abrupte (type FM ou FM abrupte).  Ce 
sont des signaux courts avec une forte variation de fréquence. Ceci veut dire que dans un 
temps très bref, la fréquence diminue par exemple de ± 100 kHz à ± 30 kHz.  Ce type de 
signal donne une information très détaillée mais suite à l’atténuation atmosphérique, la portée 
est limitée (la chauve-souris ne « voit » pas très loin).   Ce type est employé entre autres par 
les espèces du genre Myotis et par les oreillards.  Ce sonar FM abrupte est typiquement 
utilisé en milieu fermé. 

 
II. Dans le deuxième type, une première partie FM est suivie par une partie de Quasi Fréquence 

Constante (partie QFC).  En effet, dans la seconde partie du signal, la fréquence reste plus ou 
moins constante.  Puisque la partie majeure du signal est en FM, on appelle ce type de signal 
une FM aplanie.  La partie quasi fréquence constante donne à la chauve-souris une 
information moins détaillée mais également moins sujette à l’atténuation atmosphérique et 
donc à portée plus longue.  Ce type de sonar est utilisé par les chauves-souris qui chassent 
dans des habitats semi-ouverts comme par exemple les pipistrelles et les sérotines.  

 
III. L’étape suivante dans la gradation des types de sonars est le signal Quasi Fréquence 

Constante (QFC). Dans ce signal, la partie FM est moins grande et le signal est dominé par 
la partie à fréquence quasi constante.  Ce type de signal donne surtout des informations sur 
les objets situés à grande distance et est principalement utilisé par des chauves-souris qui 
chassent en milieu ouvert, comme par exemple les noctules.   

 
IV. Un quatrième type, légèrement différent, est le signal à Fréquence Constante (FC).  Parfois, 

ce type est également appelé fm-FC-fm, car aussi bien au début qu’à la fin du signal se 
trouve une petite « queue » en FM.  Ce type de sonar est utilisé par les Rhinolophes, qui 
utilisent des effets sonores particuliers (l’effet Doppler) pour interpréter les signaux.   
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Les chauves-souris ne sont pas toujours strictement liées à un des 4 types de sonar.  En fonction des 
conditions, elles adaptent leurs signaux afin d’obtenir une image optimale de leur environnement.  
Dans les habitats fermés, le signal évoluera toujours dans le sens d’une FM et dans les habitats 
ouverts, la composante QFC augmente.   
 
 
 
 
 
 
 
 
 
 
 

4.2 Quels paramètres utiliser pour l’analyse du son ?   
 
Pour l’analyse du son, un certain nombre de paramètres sont importants :  
 
Paramètres du signal (voir figure ci-dessous) 
 

 Fmax = la fréquence maximale (la + 
grande) du signal – souvent équivalente à 
la FI - fréquence initiale 

 Fmin = la fréquence minimale (la + petite) 
du signal – souvent équivalente à la FT - 
fréquence terminale 

 Fqfc = la fréquence de la partie ± 
horizontale du signal 

 DUR = la durée du signal 

 FME = la fréquence du pic d’énergie ou 
du maximum d’énergie (ce pic d’énergie 
n’est pas directement visible dans le 
spectrogramme, mais peut être visionnée 
dans le power spectrum) 

 Dans certaines études, la Fcentr est 
également mesurée, càd la fréquence à 
la moitié (en temps) du signal 

 LB = la largeur de bande = Fmax – Fmin 
ou FI – FT 

Type de sonar voir plus haut (point 4.1) 
Intervalle inter-pulse (IPI) = l’intervalle entre deux signaux consécutifs 
Forme de l’oscillogramme (voir figure ci-dessous) 
 

La forme de l’oscillogramme permet d’évaluer la 
distribution de l’énergie au sein du signal 

 
Il est fortement déconseillé de se baser sur les paramètres d’un seul signal ! C’est pourquoi dans de 
nombreuses études, on se base soit sur des moyennes de mesures de plusieurs signaux soit sur des 
mesures individuelles de plusieurs signaux d’une même série. 
 
 

kHz 

Habitat fermé > Habitat ouvert ms 
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Paramètres des signaux pour les différents types de sonar 
 
 

 
 
Différentes formes d’oscillogrammes 
 
 

4.3 Affichage d’un signal en Batsound 
 
Dans Batsound, on peut afficher les enregistrements de deux manières différentes : à l’aide d’un 
spectrogramme ou à l’aide d’un oscillogramme.   Sur l’écran ci-dessous, on voit l’oscillogramme au-
dessus et le spectrogramme en-dessous.   
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L’oscillogramme donne l’amplitude (= le niveau d’énergie, le volume) en ordonnée (Y) en fonction du 
temps en abscisse (X).  Le spectrogramme donne, lui, la fréquence en ordonnée en fonction du temps 
en abscisse. C’est surtout le spectrogramme qui est utilisé pour l’analyse du son.  

 Pour voir uniquement le spectrogramme, cliquez sur  

 Pour voir uniquement l’oscillogramme, cliquez sur  

 Pour les voir deux ensemble, cliquez sur  
 
Dans le spectrogramme, le niveau d’énergie (le volume) est affiché à l’aide de couleurs. Ces couleurs 
peuvent être configurées par le biais des Spectrogram settings (voir point 3.2.2). 
 

4.3.1 Modifier les paramètres de l’oscillogramme  
 
Quand l’enregistrement est relativement faible ou quand on dé-zoome fortement, la forme de 
l’oscillogramme n’est pas bien visible (voir figure ci-dessous).  Il est alors préférable de modifier les 
paramètres de l’oscillogramme, chose impossible via la barre d’outils, mais uniquement en faisant un 
clic droit dans la fenêtre de l’oscillogramme.  Dans le menu contextuel, sélectionnez Oscillogram 
Settings – current diagram tout en bas. 
 



 
 1199

 
 

Vespertilion de Natterer en forêt, avec un niveau d’énergie très faible, 
ce qui donne un oscillogramme peu clair. 

 
Quand vous sélectionnez Oscillogram Settings - current diagram, vous obtenez la fenêtre 
suivante : 
 

 
 
En adaptant Min and max amplitude, la forme de l’oscillogramme devient beaucoup plus lisible.  La 
valeur doit être sélectionnée en fonction de l’enregistrement.  Pour des signaux faibles, on sélectionne 
une limite inférieure et supérieure très basse (petit nombre). Pour des signaux puissants, il ne sera 
même pas nécessaire d’adapter les paramètres de l’oscillogramme.  La figure ci-dessous est 
identique à la précédente, mais avec des Min and max amplitude à -10 et 10, ce qui a pour résultat 
que l’oscillogramme remplit la fenêtre et que sa forme est beaucoup plus lisible. 
 

Oscillogramme trop 
petit, pas assez lisible 
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Le même enregistrement que plus haut (Vespertilion de Natterer en forêt), 
mais avec l’amplitude min et max de l’oscillogramme configurées à -10 et 10. 

 
 
 
 
On peut également configurer les 
paramètres standards de 
l’oscillogramme via le menu Analysis > 
Oscillogram Settings – default.  Cette 
fenêtre ne permet pas de configurer Min 
and max amplitude mais permet par 
contre de configurer le nombre de 
Milliseconds per plot (= le nombre de 
millisecondes affichées sur la largeur de 
l’écran). 
 
 
 

4.3.2 Modifier les paramètres du spectrogramme  
 
Bien que la plupart des paramètres du spectrogramme aient déjà été configurés par le biais du menu 
Analysis > Spectrogram Settings – default (voir point 3.2.2.), il est peut-être encore souhaitable de 
les modifier (par exemple augmenter ou diminuer la valeur seuil -Threshold- en fonction de la qualité 
de l’enregistrement).  Ceci peut également être fait par un clic droit dans la fenêtre du 
spectrogramme : sélectionnez Spectrogram Settings – current diagram dans le menu contextuel.   
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Vous obtenez le même écran qu’au point 3.2.2, où vous pouvez modifier les paramètres du 
spectrogramme en cours de lecture.  L’avantage est que ce sont uniquement les paramètres du 
spectrogramme en cours de lecture qui sont modifiés ; les paramètres standards restent ainsi 
sauvegardés. 
 

4.4 La prise de mesures en Batsound 
 

4.4.1 Mesures dans le spectrogramme 
 
Le spectrogramme est sans aucun doute la fenêtre la plus utilisée pour l’identification des signaux 
enregistrés.  Dans le spectrogramme, on peut mesurer FI, FT, Fmax, Fmin, DUR et IPI.  Dans 
certaines versions de Batsound, ces paramètres du signal peuvent être mesurés automatiquement, 
mais étant donné que la plupart des enregistrements présentent des parasites et que certains signaux 
comportent également des harmoniques, il est préférable de faire les mesures à la main.  Pour cela, 
utilisez le curseur de mesure, que vous trouverez en faisant un clic droit dans la fenêtre de 
l’oscillogramme : dans le menu contextuel, sélectionnez Measurement cursor (ou large 
Measurement cursor).  A la place d’une petite flèche, le curseur devient une croix.  On peut 
également utiliser le raccourci clavier Ctrl + shift + A ou y arriver via le menu Tools > Measurement 
cursor. 
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Déterminer la fréquence d’un point (FI, FT, Fmax, Fmin, Fqfc) 
 
Positionnez le curseur (càd le centre de la croix) à l’endroit voulu, la fréquence est affichée en bas à 
gauche de l’écran. De cette manière, on peut facilement déterminer FI et FT par exemple.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Attention : il est important de se rendre compte que ce qu’on voit ou mesure à l’écran n’est pas 
toujours le reflet de la réalité.  Par exemple, lorsque la chauve-souris était loin lors de l’enregistrement, 
les plus hautes fréquences émises sont tronquées (par effet d’atténuation), la FI mesurée peut donc 
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être erronée.  Ceci montre l’importance de faire des mesures sur plusieurs signaux de la même 
séquence. De même, les qualités du micro du détecteur conditionnent sensiblement le rendu du 
signal.  Le D240x a par exemple une moins bonne qualité d’enregistrement pour les hautes 
fréquences que le D1000x. Etre bien conscient des limites du micro de son détecteur permet donc 
d’éviter des erreurs. 
 
Mesurer des intervalles de temps et de fréquence (DUR et IPI, LB) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A gauche, au bas de l’écran, on peut lire de gauche à droite : le temps écoulé depuis le début de 
l’enregistrement jusqu’à la position actuelle du curseur (1.4639 s, n’intervient pas dans l’analyse), la 
fréquence de la position actuelle du curseur (14,1 kHz=FT), la différence de temps entre le point de 
départ et le point final (3,8 ms= DUR) et également la largeur de bande entre le point de départ et le 

point final (46,3 kHz=LB). 
 
Afin de mesurer des intervalles de temps, on doit sélectionner un point de départ et un point final.  Le 
point de départ est fixé en cliquant une fois avec le curseur (bouton de gauche de la souris), une croix 
apparaît sur la position sélectionnée.  Quand le curseur est déplacé vers le point final, on peut lire en 
bas à gauche de l’écran la différence de temps entre le point de départ et la position actuelle du 
curseur.  On mesure de cette manière la durée d’un signal, mais également l’IPI (utilisez comme point 
de départ le début d’un signal et comme point final le début du signal suivant).   
 
En tenant le bouton gauche de la souris enfoncé tout en se déplaçant, on peut sélectionner une partie 
de l’enregistrement (la partie sélectionnée devient foncée).  Ceci est pratique pour déterminer la durée 
du signal (DUR).  A nouveau, la différence de temps entre le début et la fin de la sélection est affichée 
en bas à gauche de l’écran. Cette façon de travailler est conseillée quand la fin du signal n’est pas 
très nette : grâce au contraste du bloc sélectionné, il est plus facile de déterminer la fin du signal (dans 
ce cas, il est souvent recommandé de s’aider de l’oscillogramme pour déterminer la fin du signal).  
 

Point de départ : 1er 
clic de la souris 

Point final : position 
actuelle du curseur 
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Sélection d’un signal pour mesurer DUR.  Dans ce cas particulier, le signal fait 3.8 ms. 
 

4.4.2 Déterminer la fréquence du maximum d’énergie (FME) à l’aide 
du power spectrum 

 
La fréquence du maximum d’énergie (ou du pic d’énergie) peut être déterminée de façon indirecte 
dans le spectrogramme où le volume sonore (en décibels) est affiché à l’aide de couleurs.  L’échelle 
de couleurs dépend des paramètres du spectrogramme et peut être modifiée via le menu Analysis > 
Spectrogram Settings. Dans l’exemple ci-dessous, le volume sonore augmente de jaune vers rouge, 
puis bleu et enfin noir.  
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Le spectrogramme ci-dessus démontre clairement qu’il y a deux pics d’énergie (couleur plus foncée).  
La fréquence du maximum d’énergie peut déjà être déterminée approximativement à l’aide du 
Measurement cursor.  Afin de la déterminer de façon précise, il est nécessaire de générer un Power 
spectrum.  
 
Pour générer un Power spectrum, il faut tout d’abord sélectionner le signal dont on veut déterminer le 

maximum d’énergie et ensuite, cliquer sur l’icône . 

Volume (énergie) croissant 
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Lorsque le Power spectrum apparaît, on peut y déterminer la fréquence du maximum d’énergie (= le 
sommet de la courbe) à l’aide du curseur (la fréquence du curseur est alors affichée en bas à gauche 
de la fenêtre).  Comme cela était déjà visible dans le spectrogramme, il y a deux pics, mais celui à 40 
kHz est le plus élevé.   
 
Conseil : Agrandissez la fenêtre du Power spectrum afin de voir les pics plus clairement. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Sur les parties en FC ou QFC, le Power spectrum peut également être fort utile pour déterminer avec 
plus de précision les FI et FT (Fmax et Fmin) d’un signal.  Pour cela, sélectionnez une toute petite 
portion du début (pour FI) ou de la fin (pour FT) du signal et faites un Power spectrum.  Le sommet de 
la courbe du Power spectrum détermine la fréquence de début ou de fin du signal.   
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Il est important de comprendre que le Power spectrum reprend toujours la totalité de la largeur de 
bande du sonogramme (de 0 kHz à 120 kHz voire plus) quelle que soit la sélection verticale effectuée 
à l’écran.  Donc, seule la « largeur » de la sélection compte et non la « hauteur » de la sélection. 
 

4.5 Identifier les espèces de chauves-souris  
 
Dans le chapitre précédent, les possibilités offertes par l’expansion de temps pour analyser les 
signaux ont été détaillées.  Dans ce chapitre, l’attention sera portée sur la détermination en soi.  Il est 
cependant important de ne jamais oublier les trois aspects suivants :  
 

 Le sonar utilisé par une chauve-souris dépend fortement des conditions dans laquelle les 
signaux ont été émis.  Il est de ce fait impossible de faire une clé de détermination parfaite. 

 L’analyse en expansion de temps est une aide à la détermination, mais n’est pas la panacée 
miracle.  Soyez honnêtes envers vous-mêmes et osez dire que vous ne savez pas déterminer 
(ou pas déterminer jusqu’à l’espèce) certains signaux. 

 Essayez d’identifier directement sur le terrain les espèces « faciles à déterminer » à l’aide de 
l’hétérodyne et évitez de postposer la détermination de trop de séquences sur base des 
enregistrements.  Cela vous permettra d’économiser du temps et de mieux juger des 
conditions et de l’environnement (voir point 1 ci-dessus). 

 
La première étape de l’identification repose sur les 2 questions suivantes :  

 A quel type de sonar avons-nous à faire ? 
 Dans quelles conditions la chauve-souris vole-t-elle ? 

 
Pour l’identification au détecteur hétérodyne, nous renvoyons le lecteur au « Manuel d’utilisation du 
détecteur d’ultrasons hétérodyne pour débutants ».  L’identification du type de sonar en Batsound est 
très facile et se fait visuellement avec le spectrogramme.  Faites juste attention à zoomer 
suffisamment dans le spectrogramme, sinon quasi tous les signaux ressemblent à des FM. 
 
Sur base de l’image ci-dessous, il est déjà possible de faire un premier classement en 4 groupes. 
Attention, certaines espèces peuvent produire différents signaux appartenant à plus d’un groupe. 
 

FC

FM aplanie 

QFC

FM 
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L’identification précise des différentes espèces en expansion de temps est très bien documentée dans 
différents ouvrages listés dans la bibliographie.  Nous vous conseillons de consulter un de ces 
ouvrages de référence pour aller plus loin. 

 
Sonar FM 

 

Le genre Myotis  
Vespertilion de Daubenton 
Vespertilion de Natterer 
Vespertilion à moustaches 
Vespertilion de Brandt 
Vespertilion d’Alcathoe 
Vespertilion à oreilles échancrées 
Vespertilion des marais 
Vespertilion de Bechstein 
Grand Murin 

Le genre Plecotus 
Oreillard roux 
Oreillard gris 

Le genre Barbastella 
 Barbastelle d’Europe 

 
Sonar FM aplanie 

 

Le genre Pipistrellus 
Pipistrelle commune 
Pipistrelle pygmée 
Pipistrelle de Nathusius 
Pipistrelle de Kuhl 

Le genre Eptesicus  
Sérotine commune 
Sérotine de Nilsson 

Le genre Nyctalus  
Noctule commune 
Noctule de Leisler 

Le genre Vespertilio 
Sérotine bicolore 

Le genre Myotis 
Vespertilion des marais 

 
Sonar QCF Le genre Pipistrellus 

Pipistrelle commune 
Pipistrelle pygmée 
Pipistrelle de Nathusius 
Pipistrelle de Kuhl 

Le genre Eptesicus  
Sérotine commune 
Sérotine de Nilsson 

Le genre Nyctalus  
Noctule commune 
Noctule de Leisler 

Le genre Vespertilio 
Sérotine bicolore 

 
Sonar FC 

Le genre Rhinolophus  
Grand Rhinolophe 
Petit Rhinolophe 
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Annexe 1 : Références 
 

Détecteurs en expansion de temps  

(portables ou enregistrement automatique) 
 

Modèle Producteur - Contact 
Portable : 
 D240x 
 D1000x 
 
Enregistrement automatique : 
 D500x 

 

Pettersson Elektronik AB 
     Uppsala Science Park 
     Dag Hammarskjolds v. 34A 
     S-751 83 Uppsala 
     Suède 
Tél : +46 1830 3880  
Fax : +46 1830 3840  
 
e-mail: info@batsound.com 
http://www.batsound.com 
 

Portable : 
 Laar TR 30 
 
Enregistrement automatique :  
 Laar TDM 7 D II 

Laar Technology and Consulting  
BVL von Laar 
     Gut Klein Goernow 
     D-19406 Klein Goernow 
     Allemagne 
Tél : +49 3847 451145 
 
e-mail: info@laartech.biz 
http://www.laartech.biz 
 

Portable : 
 Batbox Griffin 
 

Batbox • LTD 
     2A Chanctonfold 
     Horsham Road 
     Steyning 
     West Sussex 
     BN44 3AA 
     Royaume-Uni 
Tél/Fax : +44 1903 816298 
 
e-mail : info@batbox.com 
http://www.batbox.com/griffin.html 
 

Portable : 
 Echo Meter EM3+ 
 
Enregistrement automatique :  
 Song Meter SM2bat+  
 SM3bat 
 

Wildlife Acoustics, Inc. 
     3 Clock Tower Place, Suite 210 
     Maynard, MA 01754-2549 
     USA 
Tél : +1 978 369 5225 
 
e-mail : sales2014@wildlifeacoustics.com   
http://www.wildlifeacoustics.com/  

Enregistrement automatique : 
 Batlogger  
 

Elekon AG 
     Cheerstrasse 16 
     CH-6014 Luzern 
     Suisse 
Tel. +41 41 250 40 40 
Fax +41 41 250 40 43 
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e-mail : mail@elekon.ch 
http://www.elekon.ch/en/batlogger/products/batlogger_/  

Enregistrement automatique : 
 Batcorder 
 

ecoObs technology & service GmbH 
     Tolstoistrasse 8 
     90475 Nürnberg 
     Allemagne 
Tél : +49 (0)911 - 37680 53 
Fax: +49 (0)911 - 37680 55 
 
e-mail : info@ecoobs.de 
http://www.ecoobs.com/cnt-batcorder.html 

 

Logiciels d’analyse 
 

Logiciel Producteur - Contact 
Avisoft-SASLab Pro Laar Technology and Consulting  

BVL Von Laar 
     Gut Klein Goernow 
     D-19406 Klein Goernow 
    Allemagne 
Tél : +49 3847 451145 
Fax : +49 3847 451146 
 
e-mail: info@laartech.biz 
http://www.laartech.biz 
 

BatExplorer 
(uniquement 
compatible avec les 
fichiers du Batlogger) 
 

Elekon AG 
     Cheerstrasse 16 
     CH-6014 Luzern 
     Suisse 
Tel. +41 41 250 40 40 
Fax +41 41 250 40 43 
 
e-mail : mail@elekon.ch 
http://www.elekon.ch/en/batlogger/products/batexplorer_sw/  

Batsound Pettersson Elektronik AB 
     Uppsala Science Park 
     Dag Hammarskjolds v. 34A 
     S-751 83 Uppsala 
     Suède 
Tél : +46 1830 3880  
Fax : +46 1830 3840  
 
e-mail: info@batsound.com 
http://www.batsound.com 
 

BatScan Batbox • LTD 
     2A Chanctonfold 
     Horsham Road 
     Steyning 
     West Sussex 
     BN44 3AA 
     Royaume-Uni 
Tél/Fax : +44 1903 816298 
 
e-mail : info@batbox.com 
http://www.batbox.com/batscan.html 
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SonoBat SonoBat

315B Park Ave 
Arcata, CA 95521 
USA 
Tél : +1 707 826 7443 
 
e-mail : info@sonobat.com 
http://www.sonobat.com 
 

Praat Logiciel gratuit développé par  
Paul Boersma et David Weenink    
     Phonetic Sciences 
     University of Amsterdam 
     Spuistraat 210 
     1012VT Amsterdam 
     Pays-Bas  
Tél : +31-20-5252385 ou +31-20-5252187 
 
e-mail : paul.boersma@uva.nl -     
             david.weenink@uva.nl 
http://www.fon.hum.uva.nl/praat/ 
 

Syrinx Logiciel gratuit développé par 
John Burt 
     Electrical Engineering / Psychology Department 
     University of Washington 
     Seattle, WA 98195 
     USA 
 
e-mail : quill@u.washington.edu -      
             quill@bigfoot.com 
http://syrinxpc.com/ 
 

WaveSurfer Logiciel gratuit développé par  
     School of Computer Science and Communication 
     Department of Speech, Music and Hearing 
     Kungliga Tekniska högskolan,  
     100 44 Stockholm 
     Suède 
Tél : +46 8 790 60 00 
 
http://www.speech.kth.se/wavesurfer/  
http://sourceforge.net/projects/wavesurfer/  

Audacity Logiciel libre développé par une communauté de 
contributeurs pour l’open source 
http://audacity.sourceforge.net/about/ 
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Littérature intéressante 
 
Livres : 

 Barataud, M. 2012. Ecologie acoustique des chiroptères d’Europe, Biotope Editions  Ce livre 
est accompagné d’un DVD portant de nombreuses séquences acoustique, tenant lieu de CD de 
référence également. 

 Briggs, B. and King, D. 1998.  The Bat Detective, a Field Guide for Bat Detection. Stag 
Electronics.  Ce livre est accompagné d’un CD. 

 Russ, J. 2012 British Bat Calls : A Guide to Species Identification, Pelagic Publishing 
 Russ, J. 1999. The Bats of Britain and Ireland. Echolocation Calls, Sound Analysis and 

Species Identification. Alana Books, Belfast. 
 Skiba, R. 2003. Europäische Fledermäuse. Kenzeichen, Echoortung und 

Detektoranwendung. Westarp Wissenschaften-Verlagsgesellschaft mbH, Hohenwarsleben, 
Germany. 

 Tupinier, Y. L’univers acoustique des chiroptères d’Europe. Sittelle (www.sittelle.com) 
 
CD : 
 
 Ballade dans l’inaudible. M. Barataud. Sittelle (www.sittelle.com) 
 Méthode d'identification acoustique des chiroptères d'Europe. M. Barataud. 2002. Sittelle 

(www.sittelle.com) 
 Guide sonore de la plupart des espèces belges de chauves-souris. Vleermuizenwerkgroep 

Natuurpunt et Plecotus Natagora (plecotus@natagora.be) 
 CD de référence pour le vespertilion des marais (Myotis dasycneme) et le vespertilion de 

Daubenton (Myotis daubentoni). Vleermuizenwerkgroep Natuurpunt et Plecotus Natagora 
(plecotus@natagora.be) 

 
 
Articles : 
 
 Ahlen, I. and Baagoe, H.J. 1999. Use of utrasound detectors for bat studies in Europe : 

experiences from field identification, surveys, and monitoring. Acta Chiropterologica 1: 137-
150. 

 Holderied, M. W., Jones, G. and von Helversen, O. 2006. Flight and echolocation behaviour of 
whiskered bats commuting along a hedgerow: range-dependent sonar signal design, 
Doppler tolerance and evidence for ‘acoustic focussing’. The Journal of Experimental Biology 
209: 1816-1826 

 Jones, G. 1999. Scaling of echolocation call parameters in bats, The Journal of Experimental 
Biology 202: 3359–3367 

 Parson, S. and Jones, G. 2000. Acoustic identification of twelve species of echolocating bat 
by discriminant function analysis and artificial neural networks. Journal of Experimental 
Biology 203: 2641-2656. 

 Russ, J. M., Jones G., Mackie, J. and Racey P.A. 2004. Interspecific responses to distress 
calls in bats (Chiroptera: Vespertilionidae): a function for convergence in call design? 
Animal Behaviour 67 : 1005-1014 

 Russo, D. and Jones, G. 2002. Identification of twenty-two bat species (Mammalia: Chiroptera) 
from Italy by analysis of time-expanded recordings of echolocation calls. Journal of Zoology, 
London 258: 91-103. 

 Siemers, B.J. and Schnitzler, H.-U. 2004. Echolocation signals reflect niche differentiation in 
five sympatric congeneric bat species. Nature 429 : 657-661. 
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Annexe 2 : Enregistreur 

Les enregistreurs MP3/WAV 

 Ces enregistreurs digitaux sont la technologie la plus récente utilisée pour l’instant. Ils 
stockent les enregistrements dans une carte mémoire ou un disque dur similaire à celui d’un 
ordinateur.  

 Les enregistrements stockés en format MP3 et MP4 ne peuvent pas être lus tel quels par 
Batsound mais doivent être transformés en fichiers .wav à l’aide d’un petit logiciel.  Le 
problème, c’est que la compression MP3 et MP4 détruit une part considérable des 
informations nécessaires pour l’analyse, ce qui rend leur interprétation difficile. 

 Ils peuvent stocker des quantités importantes d’enregistrements (plusieurs heures 
d’enregistrements, même sur les modèles avec la plus petite mémoire). 

 Chez ces enregistreurs digitaux, il y a un délai de quelques secondes entre le déclenchement 
du bouton d’enregistrement et le début réel de l’enregistrement. Ceci signifie que l’on manque 
une partie des cris de la chauve-souris. 

 Le plus grand avantage d’utiliser un enregistreur de ce type et qu’ils permettent un transfert 
direct (très rapide) des enregistrements sur l’ordinateur (via le port UBS ou un câble fourni 
avec l’appareil), étant donné qu’ils stockent les enregistrements directement sous forme de 
fichiers. 

Alternatives aux enregistreurs 

 Il est également possible, quand les conditions le permettent (terrain plat et temps sec ou 
position statique), de travailler directement sur le terrain avec l’ordinateur.  Le détecteur est 
alors relié à l’ordinateur par un cable jack-jack (le même que celui qui est utilisé pour relier le 
détecteur et l’enregistreur).  Ceci a comme avantage de pouvoir visualiser directement les 
signaux que l’on vient d’enregistrer. Actuellement de nouveaux microphones ultrasoniques 
apparaissent sur le marché (par exemple Pettersson M500) qui permettent une connexion 
directe avec un pc ou une tablette par câble USB (par exemple le pack Soundchaser) ou en 
direct sur iPad (par exemple Wildlife Acoustics Echo Meter Touch).  

 Tous les détecteurs hauts de gamme (D1000x de Pettersson ou Batbox Griffin par exemple) 
possèdent maintenant une carte mémoire intégrée au détecteur.  L’enregistreur est donc 
inclus dans le détecteur.  Le transfert des enregistrements vers l’ordinateur se fait en général 
à l’aide d’un lecteur de carte (de type carte d’appareil photo) sur le port USB.  


